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products. Attempts to break Microchip’s code protection feature may be a violation of the Digital Millennium Copyright Act. If such acts
allow unauthorized access to your software or other copyrighted work, you may have a right to sue for relief under that Act.
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Object of Declaration: MCP19117 Flyback Stand-Alone Evaluation Board User’s Guide

EU Declaration of Conformity

Manufacturer: Microchip Technology Inc.
2355 W. Chandler Blvd.
Chandler, Arizona, 85224-6199
USA

This declaration of conformity is issued by the manufacturer.

The development/evaluation tool is designed to be used for research and development in a laboratory
environment. This development/evaluation tool is not intended to be a finished appliance, nor is it
intended for incorporation into finished appliances that are made commercially available as single
functional units to end users. This development/evaluation tool complies with EU EMC Directive
2004/108/EC and as supported by the European Commission’s Guide for the EMC Directive 2004/108/EC
(8" February 2010).

This development/evaluation tool complies with EU RoHS2 Directive 2011/65/EU.

This development/evaluation tool, when incorporating wireless and radio-telecom functionality, is in
compliance with the essential requirement and other relevant provisions of the R&TTE Directive
1999/5/EC and the FCC rules as stated in the declaration of conformity provided in the module
datasheet and the module product page available at www.microchip.com.

For information regarding the exclusive, limited warranties applicable to Microchip products, please see
Microchip’s standard terms and conditions of sale, which are printed on our sales documentation and
available at www.microchip.com.

Signed for and on behalf of Microchip Technology Inc. at Chandler, Arizona, USA

(2= Sepn- /Y
Derek Carlson Date
VP Development Tools
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Preface

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and
documentation are constantly evolving to meet customer needs, so some actual dialogs
and/or tool descriptions may differ from those in this document. Please refer to our web site
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each
page, in front of the page number. The numbering convention for the DS number is
“DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the
document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help.
Select the Help menu, and then Topics to open a list of available online help files.

INTRODUCTION

This chapter contains general information that will be useful to know before using the
MCP19117 Flyback Stand-Alone Evaluation Board. ltems discussed in this chapter
include:

* Document Layout

» Conventions Used in this Guide

* Recommended Reading

» The Microchip Web Site

» Customer Support

* Document Revision History

DOCUMENT LAYOUT

This document describes how to install the MCP 19117 Flyback Stand-Alone Evaluation
Board. It also describes how to operate the Evaluation Board. The manual layout is as
follows:

* Chapter 1. “Product Overview” — Important information about the MCP19117
Flyback Stand-Alone Evaluation Board.

» Chapter 2. “Installation and Operation” — Includes instructions on how to get
started with the MCP19117 Flyback Stand-Alone Evaluation Board.

» Chapter 3. “Graphical User Interface (GUI) Features” — Includes instructions
on the MCP19117 Flyback Standalone GUI.

» Appendix A. “Schematic and Layouts” — Shows the schematic and layout
diagrams for the MCP19117 Flyback Stand-Alone Evaluation Board.

» Appendix B. “Bill of Materials (BOM)” — Lists the parts used to build the
MCP19117 Flyback Stand-Alone Evaluation Board.

© 2016 Microchip Technology Inc. DS50002472A-page 7
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:
DOCUMENTATION CONVENTIONS

Description

| Represents

Examples

Arial font:

Italic characters

Referenced books

MPLAB® IDE User’s Guide

Emphasized text

...Is the only compiler...

Initial caps A window the Output window
A dialog the Settings dialog
A menu selection select Enable Programmer
Quotes A field name in a window or | “Save project before build”
dialog
Underlined, italic text with A menu path File>Save
right angle bracket
Bold characters A dialog button Click OK

A tab

Click the Power tab

N‘Rnnnn

A number in verilog format,
where N is the total number of
digits, Ris theradixand nis a
digit.

4'p0010, 2'hF1

Text in angle brackets < >

A key on the keyboard

Press <Enter>, <F1>

Courier New font:

Plain Courier New

Sample source code

#define START

Filenames autoexec.bat

File paths c:\mccl18\h

Keywords _asm, _endasm, static
Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New

A variable argument

file.o, where file can be
any valid filename

Square brackets [ ]

Optional arguments

mccl8 [options] file

[options]

Curly brackets and pipe
character: { | }

Choice of mutually exclusive
arguments; an OR selection

errorlevel {0]1}

Ellipses...

Replaces repeated text

var name [,
var name...]

Represents code supplied by
user

void main
{
}

(void)

DS50002472A-page 8
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Preface

RECOMMENDED READING

This user's guide describes how to use MCP19117 Flyback Stand-Alone Evaluation
Board. Other useful documents are listed below. The following Microchip documents
are available and recommended as supplemental reference resources.

* MCP19116/7 Data Sheet — “Digitally Enhanced Power Analog Synchronous
Low-Side PWM Controller” (DS20005479)

* MPLAB® X IDE User Guide — “PICkit™ 3 In-Circuit Debugger/Programmer
User’s Guide For MPLAB® X IDE” (DS52116)

THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web
site is used as a means to make files and information easily available to customers.
Accessible by using your favorite Internet browser, the web site contains the following
information:

* Product Support — Data sheets and errata, application notes and sample
programs, design resources, user’s guides and hardware support documents,
latest software releases and archived software

» General Technical Support — Frequently Asked Questions (FAQs), technical
support requests, online discussion groups, Microchip consultant program
member listing

» Business of Microchip — Product selector and ordering guides, latest Microchip
press releases, listing of seminars and events, listings of Microchip sales offices,
distributors and factory representatives

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

+ Distributor or Representative

* Local Sales Office

* Field Application Engineer (FAE)
» Technical Support

Customers should contact their distributor, representative or field application engineer
(FAE) for support. Local sales offices are also available to help customers. A listing of
sales offices and locations is included in the back of this document.

Technical support is available through the web site at:
http://www.microchip.com/support.

DOCUMENT REVISION HISTORY
Revision A (March 2016)

Initial Release of this Document.

© 2016 Microchip Technology Inc. DS50002472A-page 9
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Chapter 1. Product Overview

1.1 INTRODUCTION

This chapter provides an overview of the MCP19117 Flyback Stand-Alone Evaluation
Board and covers the following topics:

*+ MCP19117 Short Overview
* What is the MCP19117 Flyback Stand-Alone Evaluation Board?
* MCP19117 Flyback Stand-Alone Evaluation Board Kit Contents

1.2 MCP19117 SHORT OVERVIEW

The MCP19117 is a highly integrated, mixed-signal, analog pulse width-modulation
(PWM) current mode controller with an integrated microcontroller core, and offers syn-
chronous or asynchronous operation. Since the MCP19117 device uses traditional
analog control circuitry to regulate the output current or voltage, the integration of the
PIC® microcontroller mid-range core is used to provide complete customization of the
device’s operating parameters, protection levels, programmable offset, dead-times,
slope compensation and fault handling procedures.

The MCP19117 has two internal low drop-out regulators (LDOs). A 5V LDO (Vpp) pro-
vides internal power to all the digital circuitry and can supply limited external power at
the Vpp pin. A 4V LDO (AVpp) provides power to the internal analog circuitry and sup-
plies the reference voltage to the ADC. This device features synchronous low-side inte-
grated drivers and 8k Words non-volatile memory, all in a space-saving 28-pin 5x5 mm
QFN package.

To support traditional MOSFETSs, pin 20 (VpR) is used to provide input power to the two
low-side synchronous gate drivers. The evaluation board is populated with the
Microchip TC1240AECHTR voltage doubler. Resistor population provides the option of
powering Vpgr with 10V through the TC1240AECHTR voltage doubler (R19, R21
populated; R22 not populated) or 5V (R22 populated; R19, R21 not populated)
gate-drive capability.

User firmware, including device configuration, is loaded using Microchip’s MPLAB® X
Integrated Development Environment (IDE). A graphical user’s interface (GUI) is used
to communicate with and edit operating parameters of the MCP19117. The GUI com-
municates via I°C using the PICkit™ Serial Analyzer.

The GUI offers the user the ability to adjust the programmable features available in the
MCP19117. Note that the interface cannot stop the user from uploading incorrect set-
tings to the device. Incorrect settings may have unintended consequences, including,
but not limited to, unstable operation, damaging the load, and even damaging of the
MCP19117 device. It is the user's responsibility to understand the system effects of the
parameters they enter.

© 2016 Microchip Technology Inc. DS50002472A-page 11
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1.3 WHATIS THE MCP19117 FLYBACK STAND-ALONE EVALUATION BOARD?

The MCP19117 Flyback Stand-Alone Evaluation Board is intended to
demonstrate how the MCP19117 device operates in a synchronous flyback
topology. Itis configured to regulate load current and is also well-suited to drive
LED loads. Nearly all operational and control system parameters are
programmable by utilizing the integrated PIC Microcontroller core.

The MCP19117 Flyback Stand-Alone Evaluation Board is delivered
preprogrammed with firmware designed to operate with the GUI interface.
MPLAB X IDE software can be used to download user-defined firmware, thus
tailoring it to their specific application.The evaluation board contains headers
for In-Circuit Serial Programming™ (ICSP) as well as I°C communication.

Several test points have been designed into the printed circuit board for easy
access and development purposes. The MCP19117 Flyback Stand-Alone
Evaluation Board is also intended to demonstrate an optimized printed circuit
board (PCB) layout that minimizes parasitics while increasing efficiency and
power density. Proper PCB layout is critical to achieve optimum MCP19117
operation as well as power train efficiency and noise minimization. The
MPLAB X IDE, MCP19117 Flyback Standalone GUI and MCP19117 Flyback
Stand-Alone firmware are available for download from Microchip’s web site.
See Chapter 3. “Graphical User Interface (GUI) Features” for details.

1.4 MCP19117 FLYBACK STAND-ALONE EVALUATION BOARD KIT CONTENTS

The MCP19117 Flyback Stand-Alone Evaluation Board includes the following
items:

* MCP19117 Flyback Stand-Alone Evaluation Board (ADM00663)
* Important Information Sheet

© 2016 Microchip Technology Inc.
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Chapter 2. Installation and Operation

21 ABOUT THE MCP19117 FLYBACK STAND-ALONE EVALUATION BOARD

The MCP19117 is a digitally-enhanced, power analog, synchronous low-side PWM
controller. The GUI was developed to assist users in easily configuring the MCP19117
and evaluating it in their target application.

The MCP19117 Flyback Stand-Alone Evaluation Board is designed to operate from a
single supply (nominal 8V to 14V, 24V maximum). The primary side MOSFET has a
maximum Vpg rating of 100V. Users should be cautious that this 100V rating is not
exceeded when determining input and output conditions for their application. The
coupled inductor has a 2:1 ratio. The secondary MOSFET has a 200V maximum Vpg
rating.

The default configuration provides the gate drive supply (Vpr) with 10V. Adequate
ceramic and bulk capacitors are supplied on the input to reduce the root mean square
(RMS) ripple current and lessen input voltage deviation caused by load transients.
Ceramic capacitors are also provided on the output to reduce voltage ripple and
provide energy to the output while the primary side is being re-energized.

The MCP19117 Flyback Stand-Alone Evaluation Board is fully assembled, pro-
grammed and tested to evaluate and demonstrate the MCP19117 operating perfor-
mance. Users will need to download and install the MCP19117 Flyback Standalone
GUI from the Microchip website and become familiar with its operation before powering
the MCP19117 Flyback Stand-Alone Evaluation Board.

2.2 SYSTEM AND CONFIGURATION REQUIREMENTS

To power-up and run the MCP19117 Flyback Stand-Alone Evaluation Board, the
following is required:

+ MCP19117 Flyback Standalone GUI

+ MCP19117 Flyback Stand-Alone Evaluation Board

» PICKkit Serial Analyzer

For USB connectivity, the minimal physical requirement for the PC is a standard USB
2.0 port. If the board connects to the PC through a USB hub, use a self-powered hub.

The MCP19117 Flyback Stand-Alone Evaluation Board comes with preprogrammed
firmware installed to operate with the GUI. To reprogram the device, the following tools
are required:

MPLAB X IDE (version 3.05 or later)

« MPLAB® XC8 C Compiler (v1.35 or later)

+ MCP19117 Flyback Standalone Firmware

+ MCP19117 Flyback Stand-Alone Evaluation Board

» PICKkit™ 3 In-Circuit Debugger/Programmer

The MCP19117 Flyback Standalone GUI requires a Microsoft Windows® XP/7/8
operating system and a minimum screen resolution of 1024 x 768.

Note: The factory-loaded firmware requires the use of the provided GUI to
function. Without the GUI, the evaluation board does not operate.

© 2016 Microchip Technology Inc. DS50002472A-page 15
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2.3 CONNECTING POWER INPUT AND OUTPUT

Use the V|y and GND Test Points as shown below. Nominal V,y is +8V to +14V with
the Positive terminal (Red) connected to V|y and the Negative terminal (Black)
connected to GND.
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FIGURE 2-1: Applying Power to the Board.

CAUTION

Primary side MOSFET is Rated to 100V. The transformer turns ratio is 1:2.
Do NOT exceed the 100V MOSFET Rating. Primary MOSFET (OFF) VDS = 0.5 x VOUT + VIN.
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2.4 INSTALLING THE MCP19117 FLYBACK STANDALONE GUI

The MCP19117 comes programmed with generic firmware that is compatible with the
standalone GUI. ltis up to the user to modify or create new firmware dedicated to their
stand-alone application if different functionality is required.

Note: If the default firmware is modified, the GUI may no longer be compatible
with the MCP19117 Flyback Stand-Alone Evaluation Board.

Perform the following steps to install the MCP19117 Flyback Standalone GUI:

1. Download the MCP19117 Flyback Standalone GUI software package from the
Microchip web site.

2. Extract the content of the archive files on the computer.

3. Double-click the setup.exe file to start software installation. Press the Install
button in the Application Install window (Figure 2-2). After the installation

completes, the application window is displayed (as shown in Figure 3-2 of
Chapter 3. “Graphical User Interface (GUI) Features”).

Application Install - Security Warning |
Publisher cannot be verified. ﬂ,’
Are you sure you want to install this application? it

Name:

MCP19117 FLYBACK STANDALOME GLI
From (Hover over the string below to see the full domain):
C:\ Aie Location

Publisher:
Unknown Publisher

Install | Don't Install I

While applications can be useful, they can potentially harm your computer. If you do not
trust the source, do notinstall this software. More Information...

FIGURE 2-2: MCP19117 Flyback Standalone GUI Installation Window.

© 2016 Microchip Technology Inc. DS50002472A-page 17
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2.5 REPROGRAMMING THE MCP19117 FLYBACK STAND-ALONE EVALUATION
BOARD

Perform the following steps to install necessary software and begin reprogramming the
MCP19117 device:

1. If MPLAB X IDE is already installed, go to Step 2. If not, download MPLAB X IDE
from: www.microchip.com/mplabx, and follow the installation instructions.

2. Ifthe MPLAB XC8 C Compiler, or a compatible equivalent, is already installed in
MPLAB X IDE, go to Step 3. If not, you can download a free version of the
MPLAB XC8 C Compiler from: www.microchip.com/mplabxc. The user guide,
installation instructions, and download links are available on the web page.

3. Download the MCP19117 - Flyback Stand-Alone Firmware
(ADM00663_02_10403_U1-R2_Firmware.zip) from
www.microchip.com/mcp19117 under "Documentation”.

4. Unzip the MCP19117 - Flyback Stand-Alone Firmware archive. Place the
MCP19117 project folder in the desired folder location.

Note: When installed, MPLAB X IDE automatically creates a project folder. In
Windows, this folder is typically located under
drive\Users\user name\MPLABXProjects.

5. Power-up the MCP19117 Flyback Stand-Alone Evaluation Board.

6. Connect the PICKkit 3 In-Circuit Debugger to the MCP19117 Flyback Stand-Alone
Evaluation Board via the 6-pin connector J3, as seen in Figure 2-3. For more
information about PICkit 3 In-Circuit Debugger refer to the PICkit™ 3 In-Circuit
Debugger/Programmer User’s Guide For MPLAB® X IDE (DS52116).

FIGURE 2-3: PICkit 3 In-Circuit Debugger/Programmer Connected to the
MCP19117 Flyback Stand-Alone Evaluation Board.

DS50002472A-page 18 © 2016 Microchip Technology Inc.
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7. Open MPLAB X IDE to load the MCP 19117 Flyback Stand-Alone firmware. From
the File menu select Open Project (Figure 2-4).

MPLABE X IDE v3.05

File Edit View Mavigate Source Refactor Run Debug Team Tools Window Help

| New Project... Ctrl+Shift+
] New File... Cirl4M
B2 Open Project... Ctrl4Shift+0

Open Recent Project

Import

Close Project

Close Other Projects
Close All Projects
Open File...

Open Recent File

Project Groups...

Drmiart Drancrhoe

FIGURE 2-4: Opening Project in MPLAB X IDE.

8. Browse for the location of the extracted firmware. Select the
MCP19117 Stand Alone from the list, then check the Open as Main Project
option. Click the Open Project button to complete loading the file.

Open Project |

Look in: | | MPLABXProjects LI i

[EEME]MCP 19117_FLYBACK_STANDALONE Project Name:

IMCP 19117_FLYBACK_STAMDALOMNE

Recent Items

I™ | Open Required Projects:

File name: IC:\J_lsers \MPLABXProjects\MCP 19117_FLYBACK_STANDALONE Open Project
Files of type:  [project Folder = Cancel |

FIGURE 2-5: Loading Firmware into MPLAB X IDE.
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9. When the project is open, click the Make and Program Device Main Project button on the tool bar
to program the device. Wait until the program process is complete (see Figure 2-6).

Make and Program Device
Main Project Button

MPLAB X IDE v3.05 - MCP19117_FLYBACK_STANDALONE : default ] | m] LI
File Edit WView MNavigate Source Refactor Run Debug Team Tools Window Help |Q'

“ﬁﬂ‘ e || Jdefeult hd :Er'%' D'%'%'@'IPC:UXU zdcc @ W:0x0 : bank 0
Projects X | Fles | Classes | =1 | startPage x|y MPLABXStore x| |mplSiiZh x

B Q MCP19117_FLYBACK_STANDALONE
ﬁ Header Files

#1-[@F Important Files

ﬁ Linker Files

ﬁ Source Files

(@& vibraries

ﬁl‘ Loadables

S
Update_Controller() - Navigator | 7_FLYBACK_STANDALONE-Da.. X| [ Eﬁf Quick Start 9
%% %5 MCP19117 FLYBACK_STANDALONE V=
@a i-% Project Type: Application - Configuration: default l:Ii:> Get Started ‘h@ \
Device
= MeP1s1L7 @ MPLAGE IDE v8 Users - IMPORTANT .
#| Checksum: 0x1693 hud
ﬁ nﬂ" Compiler Toalchain 4 | _’d
.@. % XC8 (v1.34) [C:F.mgram Files (f(Bﬁ)\l'dicmd‘np\ch\vl‘ 34%bin] Output X | o
o Production Image: Optimization: +speed +asm
| “§’ License: Workstation - PRQ - HPA:6734 day(s) - Press for Status PICkit3 x | MCP19117 FLYBACK STANDALONE (Build, Load, ...} x |
E+-{i Memory Connecting to MPLAR PICkit 3... |
{5 Data 336 (0x150) bytes
18% | Currently loaded firmware on PICkit 3
- Data Used: 62 (0x3E) Free: 274 (0x112) Firmware Suite Version..... 01.38.10
=1 (5 Program 8192 (0x2000) bytes FiTFWare TYPe...-wonoonon.. Midrange
H 15%
| Program Used: 1218 (0x4C2) Free: 6974 (0x 1B3E) Target voltage detected
=|.-#§ Debug Tool Target device MCP19117 found.
L@ PICKitS: BUR103534188 Device ID Revision = 0
[=1-T% Debug Resources
~O Program BP Used: 0 Free: 1 The following memory area(s) will be programmed:
O Data BP: No Support program memory: start address = 0x0, end address = Ox4c3
-0 Data Capture BP: No Support configuration memory

-0 Uniimited BP (S/W): No Support

Device Erased. . _

Programming. ..
| | Programming/Verify complete -

http: ffwww.micrachip. com * | |

I
Programming/Verify Complete Result

FIGURE 2-6: Selecting and Executing the Make and Program Device Main Project in MPLAB X
IDE.

DS50002472A-page 20 © 2016 Microchip Technology Inc.



MCP19117 FLYBACK
STAND-ALONE EVALUATION

MICROCHIP BOARD USER’S GUIDE

Chapter 3. Graphical User Interface (GUI) Features

3.1  ABOUT THE MCP19117 FLYBACK STANDALONE GUI

This chapter describes the steps that are required to launch the MCP19117 Flyback
Standalone GUIL.

311 Prerequisites
Prior to starting the GUI, perform these actions:

1. Apply an input voltage in the normal operating range (8V to 14V) at the V|y and
Ground test points.

2. Connect the PICkit Serial Analyzer to the PC through USB port and then connect
the analyzer to the Control Board via the 6-pin serial connector J5 (Figure 3-1).

FIGURE 3-1: PICkit Serial Analyzer Connection to the Board.
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3.1.2

Launching the GUI

To start the GUI, select Start > All Programs > Microchip Technology

Inc. > MCP19117 FLYBACK_STANDALONE_GUI.

The interface detects the MCP19117 device automatically and is ready for use (see

Figure 3-2).
RETE
MCP15117 Ayback Standalone GUI |
r— Drivers Enable/Disable - Advanced Register Update
i~ ON * OFF = Enable Edi
: LEB PDRV Deadtime SDRV Deadtime
[~ Operating Mods IZCEnsj I 128 ns delay j I 128 ns delay j
O Quesiresonznt @' Fixed Frequency Input Current Offset Slope Compensation
r Synchromous Operstion I:m-.v.- j 59 ﬂ
— Parameters Advanced
Swiching Freauency [T27 =k ) ._i‘.ddr;ass Data Bank Select b Register
[ Heaster Update
Max Duty Cycle ﬂ - i Ho o= Fon s p
Systemt —P Fr e Iﬂ mA [~ Register 2
arameters wlh He b =HE o1 © a3
Cument Sense Resistor |20 = m = rarrs
~|~ = o | = & o1 23
— Protection S ' -
N — [ Regster £
¥ Enable Input GVLO 18 — V - m = . m & o1 o2
¥ | Enable Input UVLO |f= 3: v
Register Online Adjust
v W Ii: 31 v
L Bl e LY Address Data & Bank 0/1
— Switches Enable/Disable e |0 = e |D = Bank23 Register
nline Adjust
" Switch 1 = Switch 2 Wit | Read | © !
Test Pin
’7|QF{S {Output of Desat Comparatar) j
iiali i Check for Control
Initialize PICKit Serial h
Evaluation Board - _ Buttons
PICkit Serial comectly configured for 12C
Operating MCP15117 Evaluation Board Detected
Status -
Box
ICROCHIP
FIGURE 3-2: MCP19117 Flyback Standalone GUI - Initial Screen.
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3.2 MCP19117 FLYBACK STANDALONE GUI DESCRIPTION

As depicted in Figure 3-2, the MCP19117 Flyback Standalone GUI is divided into five
areas:

» System Parameters Area

» Advanced Register Update Area

* Register Online Adjust Area

» Control Buttons Area

» Operating Status Box Area

3.21 System Parameters Area

The following sections are available in the System Parameters Area

* Drivers Enable/Disable Section

» Operating Mode Section

» Parameters Section

* Protection Section

» Switches Enable/Disable Section
» Test Pin Section

3.2.1.1 DRIVERS ENABLE/DISABLE SECTION

The “Drivers Enable/Disable” section contains an “ON” and an “OFF” check box. If the
“OFF” check box is selected (default), the system turns off the Primary and Secondary
Drivers and all the sections in the MCP19117 Flyback Standalone GUI become read
only. In order for the sections to become editable, select the “ON” check box.

3.2.1.2 OPERATING MODE SECTION

The “Operating Mode” section controls how the Flyback converter operates. Options
are:

* Quasi-resonant: the controller will run Quasi-resonant mode and the switching
frequency will vary depending on the operation conditions.

» Fixed Frequency: the switching frequency parameters are adjustable. By default,
the check box is selected.

| ]
Cperating Mode

" Quasitesonant (* Fixed Frequency
v Synchronous Operation

r Parameters

. —_

FIGURE 3-3: Operating Mode Options.

This section also contains a selection named Synchronous Operation. When the ON
check box in the Drivers Enable/Disable section is selected, the Synchronous
Operation check box is automatically selected — setting the MCP19117 Flyback
Stand-Alone Evaluation Board to function in Synchronous mode.

If the Synchronous Operation check box is cleared, the evaluation board is set to
function in Asynchronous Operation mode, which disables the secondary driver
(SDRV).
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3.21.3 PARAMETERS SECTION

This section controls the Switching Frequency, Maximum Duty Cycle, Output Current
and Current Sense Resistor parameters, as shown in Figure 3-4

L
— Parameters

Switching Frequency Iﬂ kHz
Maxx Duty Cycle G 5
Output Currertt 200 —] mA

Curment Sense Resistor m mil

FIGURE 3-4: Parameters Options

The switching frequency is user programmable in Fixed Frequency mode over the
range of 60 kHz to 1 MHz. Switching Frequency can be adjusted in 10 kHz intervals.
The maximum duty cycle is programmable from 0 to 100%.

CAUTION

Increasing switching frequency results in increased switching losses in the MOSFETSs.
It is the user's responsibility to ensure that the MOSFETs are operated within their safe
operating range.

The Output Current can be adjusted within a range of 0 to 500 mA. The Current Sense
Resistor (R6) value on the MCP19117 Flyback Stand-Alone Evaluation Board is

200 mQ. Both of these values are used to calculate the set point value written to the
VREFCON register. Do NOT raise the resistor value in the GUI without changing the
resistor on the evaluation board to match. Failure to do so could result in damage to
the evaluation board.

Note: Attempting to write a value larger than OxFF to VREFCON is prohibited by
the GUI.
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3.21.4 PROTECTION SECTION

The “Protection” section (see Figure 3-5) allows the user to set levels for the three
adjustable protection features:

* Enable Input OVLO: specified range of 9V to 24V. The default setting is 18V. This
parameter is configurable per its specified range.

» Enable Input UVLO: specified range is 4V to 20V. The default setting is 8V. This
parameter is configurable per its specified range.

» Enable Output OVLO: configurable range between 0V and 60V. The default
setting is 40V.

— Protection
¥ Enable Input OVLO 18 =V

¥ Enable Input UVLD |a 3: v

¥ Enable Output OVLO |4I} 3: Vv

FIGURE 3-5: Protection Options.

In order for the user to be able to set different values, the corresponding check boxes
of the features must be selected. Otherwise, the protections are not applied.

The LED (marked with D2) on the evaluation board is used to indicate various fault
conditions. The firmware will flash this LED to indicate each of the following fault
conditions:

* VIN UVLO FAULT: Short Flash Routine

* VIN OVLO FAULT: Long Flash Routine

+ OUTPUT OV FAULT: Short/Long Flash Routine

Use caution when changing from these default settings to ensure that damage will not
occur. The VINUVLO, VINOVLO and Output OV controls adjust the VINUVLO, VINOVLO
and OVREFCON registers, respectively.

3.21.5 SWITCHES ENABLE/DISABLE SECTION

There are two general purpose MOSFET low-side series switches located on
MCP19117 Flyback Stand-Alone Evaluation Board (LSW1 and LSW2). The check
boxes named “Switch 1” and “Switch 2” in the Switches Enable/Disable section of the
GUI allow the user to turn these switches ON (selected) and OFF (cleared).
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3.2.1.

6 TEST PIN SECTION

The “Test Pin” section of the GUI has a drop-down menu that allows users to select and
connect test signals to GPIO GPAO. These signals are accessible at the test point
labeled TEST. The Test Pin can be configured to output several analog or digital
parameters. See Figure 3-6 for the list of signals.

= o]l

PWHM_L (PWM output after monostabls)

PWM [Oscillator Output from the Micro-controllsr)

TMRZECQ (When TMR2 equals PRZ)

OV [Owver Voltage Comparator Output)

VIN/15533

VREF ({DAC Reference voltage setting cument requlation level)
0V_REF (Reference for over votage comparator)

VBGR {Bandoap Reference)

s (Moltage proportional to VOLIT)

EA_SC (Fror amp after slope compensation output)

A2 (Secondary Cument sense amplifier output)

[P_AD (IP afier Pedestal and offset adjust)

IP_OFF (IP ofiset reference)

VDR/n (WDR/n analog driver measurement)

TEMP_SNS {Anslog voltage representing intemal temperature)
GPAD/AND

GPAT/ANT

GPAZ/ANZ

GPA3/ANI

GPB1/AN4

FIGURE 3-6: Test Pin Options.
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3.22 Advanced Register Update Area

This section of GUI gives the user more options to configure and operate the
MCP19117 Flyback Stand-Alone Evaluation Board (see Figure 3-7).

— Advanced Register Update

Leadln I_ ERgbiE. Edit
Edge g—»LEB PORV Deadime  SDRV Deadtime —g— Sccondary

B|anking M 128 nz delay j I 128 nz delay j Driver Deadtime

Primary Driver— | Ineut Cument Offset Slope Compensation g Slope
Deadtime 2 EE = Compensation
Input Current
Offset B Ragit‘:rfss Data Bank Select EpeCit.al
_ _ __ Function
_u.xli: Hwx = For C2s |- Registers
Register 2 Update Section
== N == L i
e
0x o =] 0x [n =@ o €123
—Register 4

wln oo = F o1 € as

FIGURE 3-7: Advanced Register Update Options.
Note that the Enable Edit check box must be selected in order for the section to become
editable.

The parameters have drop-down lists with predetermined values can be selected.
.The adjustable parameters are the following:

» LEB: selects a time period (in nS) for the Leading Edge Blanking

* PDRV Deadtime: sets the delay time (in nS) for the primary driver

+ SDRV Deadtime: sets the delay time (in nS) for the secondary driver

* Input Current Offset:: sets a value (in mV) in for the input current offset

» Slope Compensation: sets a value for the slope compensation

In addition, this section allows users to update up to four Special Function Registers
(SFR) at the same time. For more information on Special Function Registers, refer to

the MCP19116/7 Data Sheet — “Digitally Enhanced Power Analog Synchronous
Low-Side PWM Controller” (DS20005479).
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3.2.3 Register Online Adjust Area

The “Register Online Adjust” section of the GUI allows the user to have direct control
of register values at any time when operating the MCP19117. The device data sheet
contains information on register address locations and content. Reads and writes are
done in hexadecimal format. Users must select the proper bank, which is especially
important when executing a write. It is good practice to always execute an address read
before a write, to check for expected results. This may help prevent an unintended write
to an improper address or bank. Please note that the Update button will not update this
section.

Register Online Adjust
Address Data &+ Bank 0/1
Befo Hk o = ¢ Bark23
Wite | Read
FIGURE 3-8: Register Online Adjust Options.

3.24 Control Buttons Area

From left to right (see Figure 3-9), the following four buttons are available:
« Initialize PICKit Serial button (selectable self-test option)

* Check for Evaluation Board button (selectable self-test option)

¢ Update button

* Turn Off Drivers button

intiaize PICKR Senal | ¢ Checkfor Update | _
[T T T e T N T T v i
FIGURE 3-9: Control Buttons.

In this section the user can perform the following actions:

+ Click the Initialize PICkit Serial button for the system to check the communica-
tion between your computer and PICkit Serial Analyzer.

+ Click the Check for Evaluation Board to manually ask the system to detect the
evaluation board.

+ Click the Update button to apply the configuration settings made in “Operating
Mode”, “Parameters”, “Protection”, “Switches Enable/Disable”, and “Advanced
Register Update” areas. Clicking Update also turns on the output drivers. Note
that it does not update information in the Register Online Adjust area.

» The Turn Off Drivers button is a master stop that shuts off the output drivers.
Clicking this button disables both primary and secondary drivers.

The system communicates whether the user action was successful or not in the Oper-
ating Status Box (see Figure 3-10).
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3.25 Operating Status Box Area

This text-box provides messages and operating status to the user. By default, the text
box is blank. It is populated when actions are performed in other sections of the GUI
(see Figure 3-10). The information is system-generated and read-only.

PICkit Serial comecthy configured for 12C
MCFP 19117 Evaluation Board Detected

MicrROCHIP

FIGURE 3-10: Operating Status Box.
The following messages are examples of text that may appear in this area:

* MCP19117 Evaluation Board Not Detected
 PICKkit Serial correctly configured for 12C
* MCP19117 Evaluation Board Update Successful
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NOTES:
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Appendix A. Schematic and Layouts

A1 INTRODUCTION

This appendix contains the following schematics and layouts for the MCP19117
Flyback Stand-Alone Evaluation Board:

» Board — Schematic

» Board — Top Layer

» Board — Top Copper

* Board — Mid Layer 1

* Board — Mid Layer 2

» Board — Bottom Copper

* Board — Bottom Layer
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A.3 BOARD - TOP LAYER

J5-12C/USART
IQ2

ll_L—-ﬂE%

MICROCHIP
-—|—- ) ADMOOB63
-:|—| -wR26 f‘ C €ERoHS

MCP19117 Flyback
Evaluation Board

O O
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A.4 BOARD - TOP COPPER
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A.5 BOARD - MID LAYER 1
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A.6 BOARD - MID LAYER 2
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A.7 BOARD -BOTTOM COPPER

04-10403-R1
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A.8 BOARD -BOTTOM LAYER

04-10403-RI
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Appendix B. Bill of Materials (BOM)

TABLE 2-1: BILL OF MATERIALS (BOM)
Qty. | Reference Description Manufacturer Part Number
4 |C1,C2, DO NOT POPULATE
C9, C10
1 |C3 CAP CER 1 pF 100V 10% X7R SMD 1206 | Taiyo Yuden Co., |HMK316B7105KL-T
Ltd.
2 |C4,C5 CAP CER 10 pF 50V 20% X7S SMD 1210 | TDK Corporation |C3225X7S1H106M
2 |C6, C11 CAP CER 2.2 pyF 50V 10% X7R SMD 1206 | TDK Corporation | CGA5L3X7R1H225K160AB
1 |C7 CAP CER 4.7 yF 50V 10% X7R SMD 1206 | TDK Corporation |C3216X7R1H475K160AC
1 |C8 CAP CER 3.3 yF 50V 10% X7R SMD 1206 | TDK Corporation |C3216X7R1H335K160AC
2 |C12 CAP CER 1 pF 25V 10% X7R SMD 0603 TDK Corporation | CGA3E1X7R1E105K080AC
2 |C13,C14 DO NOT POPULATE
2 |C15,C16 CAP CER 4.7 yF 16V 10% X5R SMD 0603 | TDK Corporation |C1608X5R1C475K080AC
1 |C17 CAP CER 220 pF 50V 5% NP0 SMD 0603 |KEMET C0603C221J5GACTU
1 |C18 CAP CER 1000 pF 50V 20% X7R SMD 0603 | Panasonic® - ECG | ECJ-1VB1H102K
1 |C19 CAP CER 10000 pF 25V 10% X7R SMD 0603 | Panasonic - ECG |ECJ-1VB1E103K
1 |C20 CAP CER 1 pF 25V 20% X5R SMD 0603 Panasonic - ECG |ECJ-1V41E105M
1 |C21 CAP CER 0.1 yF 50V 20% Y5V SMD 0603 | AVX Corporation |06035G104ZAT2A
1 |D1 DIO RECTARR BAV23,215 1V 225 mA 200V | NXP BAV23,215
SMD SOT-143B Semiconductors
1 |LD1 DIO LED RED 1.8V 40 mA 10 mcd Clear Lite-On®, Inc. LTST-C190KRKT
SMD 0603
3 [Q1,Q3,Q4 |TRANS FET N-CH SIS890DN-T1-GE3 100V | Vishay Siliconix SIS890DN-T1-GE3
8.8A 52W PowerPAK 1212-8
1 1Q2 TRANS FET N-CH BSZ900N20NS3 G 200V | Infineon BSZ900N20NS3 G
15.2A 62.5W 8-PowerTDFN Technologies AG
2 |R1,R2 RES TKF 3.92 kQ 1% 1/10W SMD 0603 Panasonic - ECG | ERJ-3EKF3921V
6 |R3, RS, RES TKF 0Q 1/10W SMD 0603 Panasonic - ECG | ERJ-3GSYOR0O0OV
R15, R16,
R17, R21,
R23, R24,
R25, R26,
R27
1 |R4 RES TF 0.05Q 1% 1W SMD 0612 Susumu Co., LTD. | PRL1632-R050-F-T1
1 |R6 RES TKF 0.2Q 1% 1W SMD 0612 ROHM LTR18EZPFLR200
Semiconductor
1 |R7 RES TF 100kQ 1% 1/8W SMD 0603 Vishay MCT06030C1003FP500
Intertechnology,
Inc.
1 |R8 DO NOT POPULATE
Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The

released BOM used in manufacturing uses all RoHS-compliant components.
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TABLE 2-1: BILL OF MATERIALS (BOM) (CONTINUED)
Qty. | Reference Description Manufacturer Part Number
1 |R9 RES TKF 4.02kQ2 1% 1/10W SMD 0603 Stackpole RMCF0603FT4K02
Electronics, Inc.
4 |R10, R12, RES TKF 10k 5% 1/10W SMD 0603 Panasonic - ECG | ERJ-3GEYJ103V
R13, R14
1 |RN RES TKF 1.02kQ2 1% 1/10W SMD 0603 Panasonic - ECG | ERJ-3EKF1021V
1 |R18 RES TKF 475Q 1% 1/10W SMD 0603 Panasonic - ECG | ERJ-3EKF4750V
1 |R19 RES TKF 10Q 5% 1/10W SMD 0603 Panasonic - ECG | ERJ-3GEYJ100V
1 |R22 RES TKF 10Q 5% 1/10W SMD 0603 Panasonic - ECG | ERJ-3GEYJ100V
DO NOT POPULATE
TR1 TRANS SMPS Flyback 1:1,2:1 SMD Wirth Elektronik | 750341878
1 (U1 MCHP ANALOG PWM CONTROLLER Microchip MCP19117-E/MQ
2 MHz MCP19117-E/MQ QFN-28 Technology Inc.
1 U2 MCHP ANALOG CHARGE PUMP 5V - 11V | Microchip TC1240AECHTR
TC1240A SOT-23-6 Technology Inc.
Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The
released BOM used in manufacturing uses all RoHS-compliant components.
TABLE B-1: BILL OF MATERIALS (BOM) - MECHANICAL PARTS
Qty Reference Description Manufacturer Part Number
1 PCB Printed Circuit Board - MCP19117 — 04-10403-R1
Flyback Stand-Alone Evaluation Board
18 |DESAT_N, DESAT_P, GPA2, |MISC, TEST POINT MULTI PURPOSE | Keystone 5001
GPAG, ICOMP, IFB, IP, ISN, MINI BLACK; Electronics
ISP, PDRYV, RX/DT, SDRYV, DO NOT POPULATE Corp.
SW1, SW2, TEST, TP1,
VREF2, VS
2 J3,J5 CON HDR-2.54 Male 1x6 Gold 5.84 MH | Samtec, Inc. TSM-106-01-L-SV
SMD VERT
4 PAD1, PAD2, PAD3, PAD4 MECH HW RUBBER PAD CYLINDRI- |3M SJ61ANM
CAL D7.9 H5.3 BLACK
6 SW_1, SW_2, TP_PGND1, CON TP LOOP SILVER 3.4x5 SMD Component TP-107-2
TP_PGND2, TP_VIN, Corporation
TP_VOUT
Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The

released BOM used in manufacturing uses all RoHS-compliant components.
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